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User Interface 4.3
0
0

About UI 4.3
In This Chapter
This chapter summarizes the enhancements made to UI 4.3 and includes 
highlights of special features in UI 4.2 and later versions.
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What’s New in UI 4.3
UI 4.3 offers the following enhancements:

1. Context option. You can use an option to automatically close context 
when finishing out of a form.

2. Export to Excel. You can export to Microsoft Excel from the Search 
Results panel. Additionally, improvements to the formatting of the 
resulting spreadsheets include a frozen header, correct assignment of 
numbers and dates, and support for special characters.

3. Export reports to PDF. You can export Colleague reports to a PDF file 
format in the Report Browser.

4. History drop-down. There is an improved Form history and Person 
history drop-down.

5. View Shared Lists. You can view recently created Shared Lists from the 
Advanced Search and Create Shared List windows.

6. ImageNow. There is improved support for ImageNow.

7. Open multiple-application forms. A window prompt makes it easier to 
open forms that are accessible and function differently in separate 
applications, such as the Validation Codes (VAL) form.

8. Custom Field Sequence & Properties. Updates to the custom tabbing 
functionality make it easier to customize user-specific field settings.

9. Add to Favorites while in the Favorites panel. You can add active 
people or forms to your Favorites while in the Favorites panel.
10 Guide to User Interface 4.3, June 24, 2011
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Features in UI 4.2 and Later Versions
Features in UI 4.2 and Later Versions

Window Resizing and Form Scaling

When Colleague displays a form, it automatically resizes to minimize 
scrolling for the default window size. You can also move the form scale slider 
(see Figure 1) to resize the current form and make the information larger or 
smaller as needed. Colleague will remember the setting the next time you 
open that form. Go to the Options menu to manually set the scale for all your 
forms at once.

Figure 1: UI Form Scale Slider

Search Field

The Search field uses icons and text prompts (see Figure 2) to switch between 
Person Search and Form Search. You can click the icon to the left of the 
search text box to switch between searching for a person (human figure icon) 
or a form (computer screen icon).

Form Scale Slider
Guide to User Interface 4.3, June 24, 2011 11
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Figure 2: UI Search Field

LookUp Search Results

The Search Results panel (see Figure 3) allows the flexibility to view things 
like purchase orders or code files in a grid view, and sort on any column of 
data that is displayed.

Figure 3: UI LookUp Search Results

Features in Colleague Forms

Right-Click for Cut, Copy, and Paste 

You can cut, copy, or paste text in any field on a UI form. Select the text and 
right-click to access these options, or use the standard keyboard shortcuts 
(Ctrl+X, Ctrl+C, and Ctrl+V).
12 Guide to User Interface 4.3, June 24, 2011
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Table Controller

Whenever a field is in focus within a table on a UI form (where the fields are 
organized in rows and columns), you can “page down” to see more rows. A 
table controller is provided (see Figure 4) to make moving around and 
viewing the rows and pages of data easier.

Figure 4: UI Table Controller

Background Toggle Button

When the table controller appears on a UI form, you can toggle between 
regular and transparent table backgrounds. (see Figure 4).

Export to Excel

When the table controller appears on a UI form, you can select the Export to 
Excel button to export all rows of data to a spreadsheet (see Figure 4).

Print Form Button

The form area includes a Print Form button (see Figure 5), which allows you 
to directly print the current form along with the Person in context associated 
with the form.

Export to Excel 
Button

Scroll Buttons

Click and hold on 
“Page” to slide 
controller

Click Next Page 
after last row to 
add a new row 

Background Toggle 
Button
Guide to User Interface 4.3, June 24, 2011 13
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Figure 5: UI 4.3 Form Print Button

Form Background Color

From the Preferences dialog box, each user can select one of the available 
form background colors (light, medium, or dark) to adjust the contrast 
between the background of a Colleague form and the text fields (see 
Figure 6).

Figure 6: Form Background Color Preference Setting
14 Guide to User Interface 4.3, June 24, 2011
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Comments Dialog Box

A pop-up Comments dialog box (see Figure 7) displays messages for some 
forms. If you are allowed to create or edit comments in the dialog box, you 
can easily insert a date/time/login ID stamp into the comments using the 
Timestamp button.

Figure 7: UI Comments Dialog Box

Report Browser

UI provides a report browser with export to PDF or print options (see 
Figure 8). 

Figure 8: UI 4.3 Report Browser

Note:  You can also enter the pound sign (#) followed by Enter to 
insert a date/time/login ID stamp. 
Guide to User Interface 4.3, June 24, 2011 15
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Map Window 

If allowed by your institution, a map window is provided (see Figure 9).

Figure 9: UI Map Window

Expanded View of All People in Context 

The View All Records in Context button provides an expanded card view, 
spreading out the cards so you can view or select several at one time. From 
this view, you can select one or several people to map, save as Favorites, or 
remove from context.
16 Guide to User Interface 4.3, June 24, 2011
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Figure 10: View All Records in Context

Query Builder is Not Accessible From UI

Query Builder, a wIntegrate utility, is not accessible from UI in UI 4.2 or later. 
If you normally use Query Builder to do your work, see your Colleague 
System Administrator for details on how to continue using this utility.

AnswerNet Change Requests Resolved With UI 4.3

Many AnswerNet change requests were resolved with the release of UI 4.3. 
See your Colleague System Administrator if you need more details about the 
change requests that were resolved with this release.

Click the View All Records 
In Context button...

...to spread out all cards 
currently in context.
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Logging Into UI 4.3
In This Chapter
This chapter provides you with information about accessing and logging into 
User Interface 4.3.
Guide to User Interface 4.3, June 24, 2011 19
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Procedure for Logging Into Colleague 
with UI 4.3

Complete the following steps to log into Colleague with UI 4.3. Your system 
administrator will provide you with a web address (URL) for accessing a 
specific Colleague environment (such as test or production) with UI 4.3. Each 
Colleague environment has its own web address for starting UI 4.3. If you are 
using the Datatel Portal, you can access Colleague with UI 4.3 from the Portal 
page.

Step 1. Start UI 4.3 on your PC by opening your web browser and going to the web 
address provided by your Colleague system administrator.

The Login dialog box is displayed.

Figure 11: Login Dialog Box

Step 2. Enter your Colleague user ID and password.

Step 3. Click Login.

The Quick Tour window appears, providing you with the option to view a 
presentation about the main features available in UI 4.3. 

Note:  For Unix systems, the login dialog box will include an option for 
changing your password if your Colleague System Administrator has 
enabled this feature.

Change Password link 
appears only if enabled, 
for Unix systems only

Technical Tip: Select the Don’t Show Me Again check box if you do 
not want the Quick Tour window to appear each time you log in. You 
can access the Quick Tour at any time from the Help menu.
20 Guide to User Interface 4.3, June 24, 2011
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Step 4. Click the Play arrow if you want to view the Quick Tour presentation.

Click Close if you want to open Colleague in UI 4.3 without viewing the 
Quick Tour.
Guide to User Interface 4.3, June 24, 2011 21
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Navigating UI 4.3
In This Chapter
This chapter helps you learn how to use UI 4.3. It includes instructions for 
accomplishing various tasks, such as accessing a form, saving your work, and 
using online help.

Technical Tip: If you are familiar with earlier versions of UI, see 
“About UI 4.3” beginning on page 9 for information about the features 
and enhancements in UI 4.3.
Guide to User Interface 4.3, June 24, 2011 23
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The UI 4.3 Window
UI 4.3 is a user-friendly, intuitive interface for Colleague. 

If you are familiar with Colleague in the UI Desktop or UI Web interfaces, 
you may notice that this interface is very similar, but with some features not 
previously available. See Figure 12 for an example of the UI 4.3 interface. 
See “Parts of the UI 4.3 Window” beginning on page 25 for more details 
about each of the areas of the UI 4.3 window.

Figure 12: The UI 4.3 Window

The UI 4.3 Quick Tour provides a brief overview of many of the UI 4.3 
features. To access the quick tour, select the Quick Tour option from the 
Help menu (see Figure 13).

Search Area Tabs Context Area

Menus

Form Scale 
Slider

Form Area
Form Print
Button

Tool Bar
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The UI 4.3 Window

 

Figure 13: The Help Menu

Parts of the UI 4.3 Window

The UI 4.3 window has the following areas to help you work with Colleague 
easily and effectively.

Search Area 

The search area of the UI window, in the upper left corner (see Figure 14), lets 
you search for people or forms to work with. You can click the icon to the left 
of the search text box to switch between searching for a person (human figure 
icon) or a form (computer screen icon). In this area, you can also expand the 
search box to view previous searches or click Edit Search History to clear 
some or all of your search history. 

If allowed by your institution, you can search for a person or organization by 
clicking the Person icon and then entering information such as the name or 
ID number in the search box. You can also click the Advanced Person 
Search icon (magnifying glass icon to the right of the Search button) to 
search for person-related records using multiple customizable search 
parameters, such as part of the address and class standing. For either search 
option, the Search Results panel displays all person records that match the 
search criteria you entered. See “Person Search” on page 38 for more details.

To search for a form, type the mnemonic or words from the title of the form in 
the search box. In most cases, when you enter the mnemonic for a form in the 
search box, the form opens immediately. When you enter one or more words 
from the title of the form, the Search Results panel displays all matching 
Guide to User Interface 4.3, June 24, 2011 25
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forms. See “Form Search” on page 47 for more details. To immediately open 
a specific application/mnemonic pair, enter your search as application-
mnemonic, such as CORE-NAE. Forms opened in this way are not stored in 
your search history. Also, forms that require an explicit selection of the 
application to open will prompt you for the application when loading. 

Figure 14: The Search Area

Tabs

Figure 15 shows the following tabs available in the UI 4.3 window:

 Search Results Tab. When you search for a person or form, the search 
results appear on the Search Results panel. Search results from other 
LookUps are also displayed on the Search Results panel. This panel is 
hidden after you select the records or form you want. When the panel is 
hidden, you can click the Search Results tab to return to the results of the 
last search. If the person icon is selected in the search area, the last person-
related search results are shown. If the form icon is selected in the search 
area, the last form search results are shown.

 Navigation Tab. Click the Navigation tab to access a Colleague form by 
navigating through the Colleague menu structure, which you can use to 
view and access all menus and forms that you have permission to use. Use 
the Application drop-down menu to view the menu structure for any 
available application.

 Favorites Tab. Click the Favorites tab to access all people and forms that 
you have saved as Favorites. You can save an item to Favorites by clicking 
the Add to Favorites (gold star) button in the Context Area (for person-

Person/Form 
Search Icon 
(showing Person 
Search; click to 
switch to Form 
Search)

Enter search 
criteria here

Access recent 
search terms here

Advanced 
Person Search 
Icon

Note:  The Search Results panel only retains the results of the most 
recent form search or person search performed from the Search Area. 
Prior search results from LookUp prompts on UI forms are not retained 
on the Search Results panel.
26 Guide to User Interface 4.3, June 24, 2011
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The UI 4.3 Window
related records), the UI Form Area (for forms), or while in the Favorites 
panel.

Figure 15: Tabs in the UI 4.3 Window

Menus

With UI 4.3, menu items are available on the left side of the tool bar (which is 
just above the form area). These menus provide access to many of the UI 
controls and features.

File Menu

The File menu provides access to the following features. Many of these 
features are also available using keyboard shortcuts:

 Save. Saves data on the current form. 

 Save All. Saves data on all open forms. 

 Cancel. Cancels changes on the current form. 

 Cancel All. Cancels changes on all open forms. 

 Record Delete (if enabled). Deletes the record on the current form. Your 
Colleague System Administrator controls access to this feature.

 Detail. Accesses the detail form (or menu of available forms) from the 
current field. 

 Add Active Form to Favorites. Adds the current form to Favorites.

 Print Form. Prints the current form (size is optimized for the page). 

 Logout. Exits UI 4.3. 
Guide to User Interface 4.3, June 24, 2011 27
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Options Menu

The Options menu provides access to the following features. Many of these 
features are also available using keyboard shortcuts:

 Preferences. Accesses the Preferences dialog box, where you can change 
preferences such as the color theme, font size, and other settings. 

 Clear Search History. Accesses the Clear History dialog box, where you 
can clear search history, contexts, and form scale values. See the online 
help for the Clear History dialog box for more details about this feature. 

 Reload Colleague Session. This option lets you refresh your session with 
software updates that may have been made or loaded into the environment 
while you were logged in. This feature is used primarily in Colleague 
development environments.

 Change Password (if available). Allows you to change your password.

 Show Field Sequence. Shows the current tab sequence for fields on the 
current form. 

 Disable Custom Field Sequence (if available). Restores the default tab 
sequence for fields on the current form. If selected, this option applies to all 
forms in a UI session until this option is cleared.

 Customize Field Properties (if available). For the current form, allows the 
user to customize the default tab sequence for fields and mark fields as 
required. See the online help for the Customize Field Sequence & 
Properties dialog box for more details about this feature. 

 Set Form Scale Default. Sets the global default scale factor for all forms to 
the current scale factor (set using the slider bar at the top of the UI form 
area). Forms with individual scale factor overrides are not affected by this 
global default. 

 Clear All Form Scale Values. Clears all individual form scale factors and 
the global default scale factor. Without these scale values, forms are 
rendered using a “best fit” algorithm based on the size of the UI window. 

Help Menu

The Help menu (shown in Figure 13 on page 25) provides access to process 
and field help for the current Colleague form. It also provides access to the 
quick tour, a list of all keyboard shortcuts, and a Help About message that 
provides information such as the current UI version number. Your Colleague 
System Administrator can also add custom menu items to this Help menu to 
provide easy access to procedures and other information that is specific to 
your institution.
28 Guide to User Interface 4.3, June 24, 2011
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The UI 4.3 Window
In addition to the Help menu, help buttons are available in many areas of the 
UI window. The help buttons look like question marks, and they usually 
appear in the upper right corner of a specific area, panel, or dialog box. These 
help buttons provide information specific to the related feature. For example. 
the help button in the top right corner of the UI window provides an overview 
of the UI 4.3 interface and its features. The help button in the Context Area 
provides specific information about using the features of the Context Area, 
and the help button on the Favorites panel provides specific information 
about working with Favorites.

Information on how to customize this menu is available in the User Interface 
4.3 Installation and Administration manual.

The Context Area

The Context Area (see Figure 16 on page 31) displays one or more “cards,” 
which contain information about the current person-related records that you 
are working with. The information shown in the Context Area cards can be 
customized at your site. If you have questions or would like to propose 
changes in what is shown in the Context Area, contact your Colleague System 
Administrator. The Context Area currently displays information only for 
person-related forms. 

If the Context Area is blank, use the Person search feature to select Person or 
Organization records to work with. When you open the selected records, they 
are loaded into the Context Area as “cards.” If you have opened a person-
related form first (with no cards in the Context Area), you can use LookUp to 
search for records and load them into the Context Area as cards.

Person Cards can include photographs (if set up by your institution) and other 
identifying information about the person (such as name, address, and ID). 
Your institution can customize the information shown on the Person Cards. 
Organization Cards include similar identifying information but do not include 
photographs.

The Context Area can hold person cards, organization cards, or both 
(depending on the form you are working with). When multiple cards are 
loaded into the Context Area, you can use the Next and Previous buttons to 
scroll through the cards. 

Technical Tip: Depending on your browser settings, online help may 
appear in a new browser window each time you access help, or it may 
re-use the same browser window to display all help messages. If your 
browser re-uses the same window for all help messages, that window 
may not always come to the foreground when you access help. 
Guide to User Interface 4.3, June 24, 2011 29
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You can also select View All to see all cards currently in context (see 
Figure 17 on page 31). When viewing all cards in context, you can go to a 
specific card, or you can select one or more records to map, add to Favorites, 
or remove from context.

If privacy codes are enabled at your institution, privacy messages for a person 
are displayed over the Context Area for a few seconds then fade away. An 
exclamation mark indicator (!) in the far left of the card title area indicates 
that a privacy message is available for a person. Click this indicator to view 
the privacy message again. If the privacy settings do not allow you to access a 
person’s record, you will only be able to see the name and ID of the person, 
with a message stating that the record is not accessible because of privacy 
settings. 

If allowed by your institution, you can click the Mapping (push pin) button to 
map the addresses of the current card or all cards in the Context Area. 

Click the Add to Favorites (gold star) button to add the current card or all 
cards to your People Favorites. 

Click the Launch Copy Window (green page) button to open a new browser 
window with the contents of the current context card in a format that lets you 
select and copy the text and then paste it into another application. If you only 
want to copy one field of information from the Context Area, you can select 
and copy it directly from the context area without opening the copy window. 

Click the Context Area Help (question mark) button to access the online help 
for the Context Area.

Click the Close (x) button to close the current card or all cards in the Context 
Area.

Many of the features in the Context Area are accessible through keyboard 
shortcuts. See “Keyboard Shortcuts” on page 76 for a full list of all available 
keyboard shortcuts. 

Colleague Administrators can customize the information shown in the 
Context Area. For more information, see your Colleague System 
Administrator or the User Interface 4.3 Installation and Administration 
manual.
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The UI 4.3 Window
Figure 16: The Context Area

Figure 17: View All Cards in Context

The Form Area

The Form Area displays the Colleague forms that you are currently working 
with. See Figure 12 on page 24 for an example of the Form Area.

Several features are available in the tool bar at the top of the Form Area, 
including menus (see page 27 for a description), Context option, Save and 
Cancel buttons, the Form Scale Slider, and the Form Print button. The Save 

View All Cards  
in Context

Previous 
Card

Next 
Card

Mapping  
(if enabled)

Add to  
Favorites

Launch Copy Window Help ClosePerson Photo (if enabled)

Card Title
Bar

Privacy Indicator 
(if enabled)

Privacy Message (if enabled)
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All and Cancel All buttons enable you to save or cancel all of your changes 
simultaneously to every form that is currently open in this session. The Save 
and Cancel buttons enable you to save or cancel changes to the current form.

Form and Window Size

UI 4.3 was designed using a minimum screen resolution of 1024x768. If you 
need to make the whole UI 4.3 window larger or smaller to fit the desired 
screen space on your computer, resize the window as you would any other 
window on your computer. 

Each Colleague form is initially sized to fit within the given Form Area space. 
If you need to make a form larger or smaller, use the Form Scale Slider to 
zoom in or out. The form scale setting for individual forms is retained for 
future sessions.

To set a default scale factor for all forms, set the scale factor for the current 
form and use the Options > Set Form Scale Default option to set the factor 
for all forms. To clear all form scale values, use the Options > Clear All 
Form Scale Values option, and then click OK to confirm this action.

Note:  The Context option allows you to specify what you want 
Colleague to do with open contexts when you save or cancel from a 
form. The Auto-Close Context option also closes all contexts when 
you save the last card in the Context Area. This applies to person-
related forms only.

Technical Tip: Cancel All does not cancel all changes made to all 
people in the context area. It cancels out of any detail forms and 
cancels changes to the current record only. When you move from one 
person to the next in the context area, you are prompted to save any 
changes made to the first person. Changes are saved automatically if 
your institution has final prompting turned off. (Datatel recommends 
that final prompting be turned ON.)
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Colleague Forms in UI 4.3

See Figure 12 on page 24 for an example of a Colleague form in UI 4.3. This 
section describes each part of the form in more detail and provides 
information on how to use the features within a form.

Form Mnemonic and Name

The form name and mnemonic for the current form are displayed on a tab at 
the top of the form, just below the tool bar (see Figure 18). If one or more 
detail forms are also open, a tab is displayed for each form. The form’s 
mnemonic provides you with a quick way to identify a form. 

Figure 18: Form Mnemonic and Name

Fields

A field is any place on the form where data is displayed or where you enter 
data. In most cases, each field is accompanied by a field label indicating what 
kind of data belongs in the field.

What you are allowed to enter in a field may be restricted by Colleague. For 
example, a field may allow you to enter only letters, or numbers, or specific 
values from a list. Standard data entry fields (such as the Country field on the 
Name and Address Entry form shown in Figure 12 on page 24) have a white 
background. Inquiry fields (such as the Person ID field on the Name and 
Address Entry form shown in Figure 12) have a shaded background. Required 
fields (such as the Last Name field on the Name and Address Entry form 
shown in Figure 12) have a white background with a red outline and a red dot 
in the upper left-hand corner.

Note:  When multiple forms are open, each form has its own tab. The 
tab farthest to the right represents the active form. To ensure that each 
record is completed properly, only one form can be edited at a time. All 
forms below the current open form are inquiry only and do not allow 
input. Data on these forms is grayed out while another form is active.
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Tables

A table within a form is a set of related fields. A table can have a different 
value on each line, or row. Furthermore, there are usually several fields in 
each row of a table that are associated with each other in some way. Some 
tables are row-oriented and some are column-oriented. In either case, the 
intersection of a column and a row is referred to as an element. On the Name 
and Address Entry form shown in Figure 12 on page 24, the Phone/Ext/Type 
group of fields is an example of a table. Each phone number entered can have 
an associated extension and type, and you can enter multiple phone numbers. 

Table Operation Button

A Table Operation button enables you to insert or delete a row of data within 
a table.

Figure 19: The Table Operation Button

When you click the Table Operation button, a dialog box is displayed, as 
shown in Figure 20.

Figure 20: Select Table Operation Dialog Box

From the Select Table Operation dialog box, select one of the following 
options:

 Click Insert to insert a new row above the current row.

 Click Delete to delete the current row.

 Click Cancel to leave the row unchanged and return to editing.

Table Operation Button
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Scrolling and Exporting 

When your cursor is within table, a controller appears at the top of the table 
that lets you scroll through the rows and pages of data (see Figure 21). This 
controller also includes a Background Toggle button that lets you make the 
background transparent and an Export button that lets you export the entire 
contents of the table to an Excel spreadsheet.

If the controller blocks your view of another field on the form, you can click 
and hold the word “Page” on the controller to grab it, then move your mouse 
to slide it left or right. Release the mouse button to let go of the controller 
when it is at the desired location. 

When the last row of data in the table is shown, you can click Next Page to 
access a new blank row. If the form allows it, you can add new data on this 
blank row.

Figure 21: Scroll and Export Controller

Note:  Security restrictions apply to the fields exported to Excel. If you 
do not have access to a field in Colleague due to security, that field will 
not be exported to Excel.

Export to Excel 
Button

Scroll Buttons

Click and hold on 
“Page” to slide 
controller

Click Next Page 
after last row to 
add a new row 

Background Toggle 
Button
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Detail Button

Some forms give you only limited or summary information about a certain 
item, but provide you with the capability of moving to another form. This 
form, which is known as a detail form, provides more complete information 
on that item. 

You will know a detail form is available from a field if there is a Detail button 
to the right of the field. Such fields are referred to as detail fields. See 
Figure 22 for an example of a detail field with a detail button. 

Figure 22: Detail Button

Date/Calendar Button

A Date/Calendar button appears to the right of each date field. 

Figure 23: The Date/Calendar Button

Click the Date/Calendar button to display the calendar browser, as shown in 
Figure 24. Click the desired date in the calendar to select it.

Figure 24: Calendar Browser

Detail Button

Date/Calendar Button
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Drop-Down List Button

A Drop-Down List button appears to the right of each field that has a 
predetermined set of valid entries. Click the Drop-Down List button to 
display a list of valid codes. Click the appropriate code to select it.

Figure 25: Drop-Down List

Note:  You can also use the down arrow key to open the list, then use 
the up and down arrow keys to move through the list and highlight the 
entry you want. Press Enter to select it.

Drop-Down 
Button

Drop-Down List
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Accessing Forms and Information
You can access forms and information in several ways:

 Person Search

 Form Search

 Navigation Panel

 Favorites Panel

 LookUp

Person Search

When you use Person Search or LookUp to search for person records 
(individuals, organizations, students, etc.), the results are displayed on the 
Search Results panel. The Search Results panel has two views: card view 
and grid view. Each of these views is discussed in more detail in the following 
sections.

Person Search Results Panel: Card View

When you search for a person or corporation, the search results show all 
records that match the search criteria you entered. When viewing search 
results in Card View, you can see photos (for people) in addition to other 
information about the records, such as addresses or phone numbers. The 
information displayed in the search results for Card View can be customized 
for your institution.

To switch between Card View and Grid View, click the Card View or Grid 
View button at the top of the Search Results panel (see Figure 26).
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Figure 26: Person Search Results, shown in Card View
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Selecting Records

To select a record to work with, click anywhere on the card. When you click 
anywhere on a card, the color changes to indicate that it is selected. You can 
double-click on a single record to select it and open it in the Context Area.

Figure 27: Selecting Records Example

To select multiple records, click on more than one card. Click on a selected 
card again to cancel the selection.

In the Select # field, you can also enter the numbers of the records that you 
want to select, separated by commas for individual record numbers. Use a 
dash to enter a range of record numbers. 

Use the Select All check box to select all search results. This option selects all 
pages of search results, not just the current page of results.

Opening Records

After selecting the records you want to work with, click Open to add those 
records to the Context Area. If any records were already in the Context Area, 
new ones added from this search will appear in sequence immediately after 
the current card. The first card of the selected records will be in focus, and the 
current form will be populated with that record’s information.

Exporting Records

To export search result records to a Microsoft Excel spreadsheet, click the 
Excel icon (to the left of the Select # field). All search results records are 
exported to a spreadsheet. If the browser does not automatically open the 
spreadsheet, you are prompted to open or save it. When the export is 
complete, you can close both the informational window and dialog box.

Technical Tip: Some forms do not allow you to select more than one 
record at a time. 
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Adding a New Record (if allowed)

If you cannot find the record you want in the search results, enter A at the 
Select # text box or click the Add New Record button at the top of the 
Search Results panel. If adding a new record is not allowed, this button is not 
available (grayed out). Be sure to follow your institution’s record search 
procedures to search existing records thoroughly before adding a new record 
(to reduce the occurrence of duplicate records). When you click the Add New 
Record button, the search panel is collapsed, and you are able to enter 
information for the new record on the UI form presented.

Filtering Results

If your search results contain both person and organization records, you can 
use the filter feature to show only person records (individuals), organization 
records (organizations), or both (combined). To filter your search results, click 
the Filter drop-down and select the option that you want to use for filtering.

Sorting Results

Sorting search results is available only in Grid View. To sort search results, 
first switch to Grid View by clicking the Grid View button at the top of the 
Search Results panel if necessary. In Grid View, you can sort the person 
search results by any available column. Click once on a column header to sort 
the results by that column in ascending order (low to high or alphabetical), 
then click the column again to sort the results by that column in descending 
order (high to low or reverse alphabetical). 

Note:  The Add New Record button is enabled only if you accessed 
the Search Results panel by searching for records from the LookUp 
prompt and if the form allows you to add a new record. If you perform 
a person search first (before opening a form), the Add New Record 
button is not available because each form dictates whether new 
records can be added or not. If a form is open and you perform a 
search using the search feature rather than LookUp, the Add New 
Record button is not available. The LookUp prompt can be accessed 
by opening the form first or by finishing from the last person card in the 
Context Area. 
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Returning to Your Most Recent Set of Search Results 

To return to the most recent person search results, select the Person option in 
the search area and then open the Search Results panel. Select the Form 
option in the search area to see the most recent form search results.

Person Search Results Panel: Grid View

When you search for a person or corporation, the search results show all 
records that match the search criteria that you entered. Search results in Grid 
View are displayed in a spreadsheet format, with the results in rows and 
columns. You can sort the results on any available column. You can resize the 
columns if needed. You may have to scroll horizontally in the Search Results 
panel to see all available columns. You can click and drag a column heading 
to rearrange the columns. The information displayed in the search results for 
Grid View can be customized for your institution. 

To switch from Grid View to Card View, click the Card View button at the 
top of the Search Results panel.

Note:  The Search Results panel only retains the results of the most 
recent form search or person search performed from the Search Area. 
Prior search results from LookUp prompts are not retained on the 
Search Results panel.

Note:  Person photos are not available in Grid View. Photos are 
available in Card View only.
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Figure 28: Person Search Results Panel: Grid View

Selecting Records

To select a record to work with, click anywhere on the row for that record. 
When you click anywhere on a row, the color changes to indicate that it is 
selected. A triangle also appears in the left column to indicate that it is 
selected. Double-click on a single record to select it and open it in the Context 
Area.

To select multiple records in sequence, click on the first record you want and 
then Shift+click on the last record in the sequence. To select multiple person 
records that are not in sequence, click on the first record you want and then 
Ctrl+click on the other records.

You can also enter the numbers of the records you want to select in the Select 
# field, separated by commas for individual record numbers. Use a dash to 
enter a range of record numbers. 
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Click Select All to select all records shown in the search results. This option 
selects all pages of search results, not just the current page of results.

Opening Records

After selecting the records you want to work with, click Open to add those 
records to the Context Area. New cards added to the Context Area from this 
search will appear in sequence after existing cards.

Exporting Records

To export search result records to a Microsoft Excel spreadsheet, click the 
Excel icon (to the left of the Select # field). All search results records are 
exported to a spreadsheet. If the browser does not automatically open the 
spreadsheet, you are prompted to open or save it. When the export is 
complete, you can close both the informational window and dialog box.

Adding a New Record (if allowed)

If you cannot find the record you want in the search results, enter A at the 
Select # text box or click the Add New Record button at the top of the 
Search Results panel. If adding a new record is not allowed, this button is not 
available (grayed out). Be sure to follow your institution’s record search 
procedures to search existing records thoroughly before adding a new record 
(to reduce the occurrence of duplicate records). When you click the Add New 
Record button, the search panel is collapsed, and you are able to enter 
information for the new record on the UI form presented.

Technical Tip: Some forms do not allow you to select more than one 
record at a time. 

Note:  The Add New Record button is enabled only if you accessed 
the Search Results panel by searching for records from the LookUp 
prompt and if the form allows you to add a new record. If you perform 
a person search first (before opening a form), the Add New Record 
button is not available because each form dictates whether new 
records can be added or not. If a form is open and you perform a 
search using the search feature rather than LookUp, the Add New 
Record button is not available. The LookUp prompt can be accessed 
by opening the form first or by finishing from the last person card in the 
Context Area. 
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Filtering Results

If your search results contain both person and organization records, you can 
use the filter feature to show only person records (individuals), organization 
records (organizations), or both (combined). To filter your search results, click 
the Filter drop-down and select the option that you want to use for filtering. 

Sorting Results

In Grid View, you can sort the person search results by any available column. 
Click once on a column header to sort the results by that column in ascending 
order (low to high or alphabetical), then click the column again to sort the 
results by that column in descending order (high to low or reverse 
alphabetical). 

Returning to Your Most Recent Set of Search Results 

To return to the most recent person search results, select the Person option in 
the search area and then open the Search Results tab. Select the Form option 
in the search area to see the most recent form search results.

Advanced Person Search

The Advanced Person Search feature lets you search for person-related 
records using one or more additional criteria defined by your institution. The 
Advanced Person Search feature also lets you retrieve a previously saved 
shared list name. 

To access the Advanced Person Search dialog box, click on the Advanced 
Search (magnifying glass with plus sign) button to the right of the Search 
button. See an example of the Advanced Person Search dialog box in 
Figure 29. You can enter criteria in one or more fields on this dialog box to 
search for people that meet all of the criteria specified.

Use the Shared List Name field to retrieve your own or another user’s shared 
list (saved list). List names are always stored in all uppercase letters, 
regardless of the case used when the list was created. The last ten recently 

Note:  The Search Results panel only retains the results of the most 
recent form search or person search performed from the Search Area. 
Prior search results from LookUp prompts are not retained on the 
Search Results panel.
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created shared lists are displayed in the list. Enter the shared list name in the 
field or select the name from the list, and then click Search. The person 
records from the shared list are loaded as person search results. 

Figure 29: Advanced Person Search Dialog Box

Advanced 
Search Button

Advanced Person 
Search Dialog Box
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Procedure for Copying a List of Favorites

To create your own copy of a shared list of people in your Favorites, follow 
these steps.

Step 1. Make sure your Context Area is clear (no people cards loaded into it). If 
necessary, collapse the Person Search Results panel to get to the Context 
Area and close out all cards.

Step 2. From the Advanced Person Search dialog box, enter or select the name of 
the shared list you want to copy in the Shared List Name field. 

Step 3. Click Search. The records from the shared list are loaded as person search 
results on the Search Results panel.

Step 4. From the Search Results panel, click Select All, then Open to load all 
records into the Context Area. 

Step 5. From the Context Area, select the Add to Favorites (gold star) button and 
select Add All to Favorites. 

Step 6. Create a folder for the list, and then click Add. 

Form Search

When you search for a form, the search results show all records that match the 
search criteria you entered. 

Note:  If you save a copy of a shared list in your Favorites, remember 
that the list in your Favorites is a local copy. If changes are made to 
either the shared list or to your local copy, the lists will no longer be 
identical. If you want to be sure you are working with the correct and 
current shared list of people each time, select the shared list on the 
Advanced Person Search each time rather than selecting the copy in 
your Favorites.
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The results are displayed in Grid View, with the results in rows and columns. 
Icons also indicate the type of form (maintenance, inquiry, report, or 
procedure). You can sort the results on any available column. You can resize 
the columns if needed, and you may have to scroll horizontally in the Search 
Results panel to see all available columns. 

In most cases, when you enter a mnemonic in the form search text box, that 
form appears right away and the search results are not shown. If a mnemonic 
exactly matches the form search term entered, that form opens. If you enter a 
word or part of a word in the title of a form, the Search Results panel shows 
all forms that match the criteria entered. 

To immediately open a specific application/mnemonic pair, enter your search 
as application-mnemonic, such as CORE-NAE. Forms opened in this way are 
not stored in your search history. Also, forms that require an explicit selection 
of the application to open will prompt you for the application when loading.

When you see the Form Search Results panel, you can either select one of 
the forms shown or start a new search.

Selecting a Form

To select a form from the Form Search Results panel, click anywhere on the 
row for that form. You can only select one form from the Search Results 
panel. The selected row changes color to show which form is selected.

Opening a Form

To open a form from the Form Search Results panel, double-click on it. You 
can also open the selected form by clicking Open. 

Sorting Results

Click once on a column header to sort the results by that column in ascending 
order (low to high or alphabetical), then click the column again to sort the 
results by that column in descending order (high to low or reverse 
alphabetical). 
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Returning to Your Most Recent Set of Search Results 

To return to the most recent form search results, select the Form option in the 
search area and then open the Search Results tab. Select the Person option in 
the search area to see the most recent person search results.

Navigation Panel

Use the Navigation panel to locate a Colleague form by navigating through 
the Colleague menu structure. The Navigation panel shows all menus and 
forms that you are able to access in Colleague. To access the Navigation 
panel, click the Navigation tab. See Figure 30 for an example of the 
Navigation panel.

Select the application you want to work with from the application drop-down 
list at the top of the Navigation panel. When the menus load, click on a menu 
to expand it. Menus can include other menus, so you can continue to expand 
them until only forms are listed. 

When you see the form you want to access, highlight it and click Open to 
open it. You can also double-click on the form name to open it. 

In the top right corner of the Navigation panel, two buttons control how 
menus are expanded. Click the Single Expand button to expand only the 
selected menu and collapse any other menus that are currently expanded. 
Click the Multi Expand button to keep currently expanded menus open when 
you expand a new one. With this option, expanded menus will remain 
expanded until you explicitly collapse them.

Note:  The Search Results panel only retains the results of the most 
recent form search or person search performed from the Search Area. 
Prior search results from LookUp prompts are not retained on the 
Search Results panel.
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Figure 30: Navigation Panel
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Favorites Panel

Use the Favorites panel to retrieve and manage saved people or forms. To 
access the Favorites panel, click the Favorites tab. See Figure 31 for an 
example of the Favorites panel.

Figure 31: Favorites Panel

Adding a Person or Form to Favorites

You can add one or more people to your Favorites by clicking the Add to 
Favorites button (gold star) in the Context Area. When you click this button, 
you can choose to add only the current person to Favorites, or all people 
currently in the Context Area to Favorites. 

To add the current form to your Favorites, click the Add to Favorites (gold 
star) button in the upper right corner of the UI Form area.

You can also add all active people or the active form to your Favorites by 
clicking the Add to Favorites button (gold star) directly in the Favorites 
panel.

When you click the Add to Favorites button, the Add to Favorites dialog 
box appears. You can select an existing folder or create a new one to store the 
selected Favorites. For more details on how to use the Add to Favorites 
dialog box, click the Help button in the dialog box.
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Selecting People from Favorites

To select a favorite person, navigate through the folders to locate the person 
record that you want to work with. 

Click the record to highlight it, and then click Open to add that person’s 
record to the Context Area. You can also double-click on a record to open it.

To retrieve multiple people from Favorites, navigate through the folders and 
locate the people you want to work with. Highlight one person, and then use 
Shift+click to highlight a continuous group of people. Use Ctrl+click to 
highlight multiple people that are not in a continuous list. Click Open to add 
all highlighted people to the Context Area.

To retrieve an entire folder of people records from the Favorites panel, 
highlight the folder name, and then click Open to add all records in that folder 
to the Context Area. You can also double-click a folder name to add all 
records in that folder to the Context Area.

Selecting a Form from Favorites

You can only select one form at a time from Favorites. Navigate through the 
folders to locate the form you want. Click the form to highlight it, and then 
click Open.

Note:  To expand a folder, click the triangle to the left of the folder 
name.

Note:  To expand a folder, click the triangle to the left of the folder 
name.
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Selecting People and Forms Together from 
Favorites

If allowed, from the Favorites panel, you can select one or more people and a 
person-related form at the same time. Highlight the people you want to work 
with, and then highlight the form you want to use. Click Open. The people are 
added to the Context Header, and the form is opened with the first person’s 
information loaded in. 

Managing Favorites

From the Favorites panel, you can drag items from one folder to another. You 
can also drag entire folders to different levels within the folder structure. 

In the upper right corner of the People Favorites area and the Form Favorites 
area, there is an Options button with a drop-down list of available options. 
Use these options to manage your Favorites:

 Create Shared List (available only from the People Favorites Options 
button). Use this option to create a shared list of people records (stored as a 
saved list in Colleague). Select one or more people from your Favorites, or 
a folder of people, and then click Create Shared List to create a list that 
can be shared with coworkers. For example, if you create a list of students 
that is the definitive list of students in the class of 2010, you can share that 
list with other users who need to work with the same list of students. The 
shared list ensures that everyone works with the same group of people, and 
individual users do not have to create their own list. When you select this 
option, the Create Shared List dialog box appears. For more details on 
how to use the Create Shared List dialog box, click the Create Shared List 
Help button. 

 Recently Created Shared List. Use this option to view the last ten recently 
created shared lists.

 Collapse All. Use this option to collapse all Favorite People or Form 
folders.

 Expand All. Use this option to expand all Favorite People or Form folders.

 Rename. Use this option to edit or rename a folder or item in your list of 
saved people or forms. Highlight the folder or item you want to rename, 

Note:  When selecting people and a form together, person information 
is only loaded into the form if it uses the person record as the primary 
LookUp. Otherwise, the selected people are loaded into the Context 
Area but not used until you open a form that uses the person record 
as the primary LookUp.
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and then select Rename from the Options button drop-down menu to edit 
or rename the selected item.

 Remove Selected. Use this option from the People Favorite Options 
button to remove one or more people or people folders from your Favorites. 
Use this option from the Form Favorite Options button to remove one or 
more forms or form folders from your Favorites. Select the items you want 
to remove, and then select Remove Selected from the Options button 
drop-down menu to remove them from your Favorites.

Note:  This option does not change the name of the person or form in 
Colleague. The item is renamed only in your Favorites.
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LookUp

Most maintenance forms require you to select a specific record to view or 
maintain. For example, to register a student for a course section, you must 
first select the student and the course section to work with. 

You specify the record to work with by responding to the LookUp prompt that 
is displayed after you access a form. LookUp prompts are labeled according 
to the type of LookUp you are performing.

LookUps pertaining to people or organizations are referred to as person-
related and organization-related LookUps. Examples include Person LookUp, 
Student LookUp, Applicant LookUp, and Vendor LookUp. 

In UI 4.3, Person-related LookUps are bypassed if the form uses Person 
LookUp as the primary LookUp and you already have one or more person 
cards in the Context Area. If you access a person-related form first, and there 
are no person cards in the Context Area, a LookUp prompt is presented. 

All LookUps show the results of the LookUp as search results on the Search 
Results panel. 

Primary LookUps for a form are displayed as LookUp prompts that pop up as 
dialog boxes. However, some fields within forms are validated against other 
files. LookUp is used within such fields to help you locate valid codes or 
items that you want to associate with the main record on which you are 
working. When you are in a field that is validated against another file, you 
will see a LookUp indicator in the lower left corner of the form, as shown in 
Figure 32.

Figure 32: Example LookUp Indicator for a Field on the NAE Form
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Guide to User Interface 4.3, June 24, 2011 55
© 2011 Datatel, Inc.



User Interface 4.3: Navigating UI 4.3
Using LookUp to Find Records

If you know the ID, or key, for the record that you need, you can simply enter 
it at the LookUp prompt. For example, Bruce Miller’s ID number is 0000205. 
If you enter 0000205 at the Person LookUp prompt for the Name and 
Address Maintenance (NAE) form, information about Mr. Miller is displayed.

Figure 33: Person LookUp Prompt

When you do not know the record ID, LookUp provides a number of options 
that help you find the record using the information you do have available. 

For example, if you do not know Mr. Miller’s ID number, you can enter his 
last name at the Person LookUp prompt. If you enter “miller” at the Person 
LookUp prompt for the NAE form, the Person Search Results panel displays 
a list of all the people in your database whose names begin with “Miller.” You 
can then select Bruce Miller from this list. 

You can use many shortcuts when working with LookUp prompts. See 
“LookUp Shortcuts” beginning on page 56 for more information about 
finding multiple records.

LookUp Shortcuts

There are a number of standard LookUp options available to help you with 
almost all types of LookUp. 

Note:  LookUp shortcuts are also available when using the Person 
Search feature in UI 4.3.  
 
If the form allows you to add a person record, you are only able to add 
a new record by using Person LookUp. You cannot add a new record 
when using the Person Search feature.
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In addition to these standard options, many types of LookUp also provide 
special shortcuts to help you find what you are looking for. See “Person and 
Organization LookUp Shortcuts” beginning on page 60 for more information 
about special LookUps.

Standard LookUp Shortcuts

There are several LookUp shortcuts that work with most types of LookUp. 
LookUp options that do not work for person-related and organization-related 
LookUps are noted in the “Hints” column in Table 1.

Technical Tip: The shortcuts may be modified by your system 
administrator. Please verify them with your system administrator if they 
work differently in your environment. The shortcuts can also be used 
in search boxes.

Table 1:  Standard LookUp Shortcuts  

Example Scenario LookUp Prompt Entry Hints

The last record you displayed 
during this login session.

An “at” sign (@)

For example, both the Name and 
Address Maintenance (NAE) form 
and the Address Maintenance 
(ADR) form are people-related 
forms. If you display Fred Smith’s 
record on the NAE form, and then 
you access the ADR form, you can 
retrieve Mr. Smith’s record on the 
ADR form by entering @.

The “at” (@) sign allows you to 
retrieve the last form-appropriate 
record you displayed in most, but not 
all, cases.

A list of all records appropriate 
for this form.

An ellipsis (...) Due to the size of Person and 
Organization LookUp, the ellipsis is 
not supported for these files.

A list of fields in the file that 
contains the record you are 
seeking.

A semicolon (;) You can use the field names to 
construct a query statement to look 
for a record.

All records in which a specific 
field contains a value (that is, 
the field is not blank).

;fieldname

For example, on the Approvals 
Needed (APRN) form in the 
Colleague Finance Accounts 
Payable module, to see a list of 
approval records for individuals who 
are limited in the purchase order 
amount they may approve, enter the 
following:

;apprv.po.max.amt
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All records in which a specific 
field’s value matches a 
particular string.

;fieldname string

For example, on the APRN form in 
the Colleague Finance Accounts 
Payable module, to see a list of 
approval records for individuals who 
can approve up to $10,000 on a 
purchase order, enter the following:

;apprv.po.max.amt  
10000

Text values, such as “Hall,” are often 
case-sensitive.

With the exception of a person’s 
name, multiword values must be 
enclosed within double quotes.

You can also look for multiple values 
at one time. For example, to see a 
list of approval records for 
individuals who can approve up to 
$10,000 or up to $15,000 on a 
purchase order, enter the following:

;apprv.po.max.amt  
10000 15000

All records in which a specific 
field’s value begins with a 
particular string.

;field string...

For example, on the Job Skill 
Definition (JSKL) form in the 
Colleague HR Personnel module, to 
see a list of all job skill definitions 
whose descriptions begin with the 
word “Typing” or “Type,” enter the 
following:

;jsk.desc Typ...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know how it starts.

Remember that text values, such as 
“Typ,” are often case-sensitive.

All records in which a specific 
field’s value contains a 
particular string.

;fieldname  
...string...

For example, on the JSKL form in 
the Colleague HR Personnel 
module, to see a list of all job skill 
definitions whose descriptions have 
the word “Typing” or “Type” in them, 
enter the following:

;jsk.desc ...Typ...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know that it contains a certain word 
or part of a word.

Remember that text values, such as 
“Typ,” are often case-sensitive.

All records in which a specific 
field’s value ends with a 
particular string.

;fieldname 
...string

For example, on the JSKL form in 
the Colleague HR Personnel 
module, to see a list of all job skill 
definitions whose descriptions end 
with the word “Wpm,” enter the 
following:

;jsk.desc ...Wpm

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you are 
fairly certain about how it ends.

Remember that text values such as 
“Wpm,” are often case-sensitive.

Table 1:  Standard LookUp Shortcuts (cont’d)

Example Scenario LookUp Prompt Entry Hints
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All records in which a specific 
file’s value contains several 
strings.

;fieldname 
...string1...string2

or any combination of strings and 
ellipses to achieve the desired 
result.

For example, on the JSKL form in 
the Colleague HR Personnel 
module, to see a list of all job skill 
definitions whose descriptions 
contained the word “Typing” followed 
by the number “80,” enter the 
following:

;jsk.desc  
...Typing...80...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know that it contains certain words 
or parts of words. You can use any 
combination of ellipses and strings 
to find what you are looking for.

Remember that text values, such as 
“Typing,” are often case-sensitive.

All records in which a specific 
field’s value is related in some 
way to a particular string (for 
example, is greater than or 
less than something).

;fieldname operator  
string

The following are valid operators:

• = or EQ (equal)

• <> or NE (not equal)

• > or GT (greater than)

• >= or GE (greater than or 
equal to)

• < or LT (less than)

• <= or LE (less than or equal to)

• UNLIKE (use this operator only 
when you use an ellipsis in 
specifying a data value)

For example, on the APRN form in 
the Colleague Finance Accounts 
Payable module, to see a list of 
approval records that were added on 
or after January 1, 2009, enter the 
following:

;approvals.add.date  
ge 010109

Table 1:  Standard LookUp Shortcuts (cont’d)

Example Scenario LookUp Prompt Entry Hints
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Person and Organization LookUp Shortcuts

The information most commonly used to look for a person or organization is 
the name of the person or organization. Table 2 presents the LookUp shortcuts 
that you can use with person-related and organization-related LookUps. These 
shortcuts also correspond to the available options on the Advanced Person 
Search dialog box.

Table 2:  Person-Related and Organization-Related LookUp Shortcuts  

Example Scenario LookUp Prompt Entry Hints

Search using a person’s name. lastname (at least the first 2 letters)

lastname, firstname

lastname, firstname 
middlename

lastname, firstname 
middleinitial

firstname lastname

firstname middlename 
lastname

firstname middleinitial 
lastname

For example, to look for or add a new 
person with the name of Robert 
Taylor Smith, you could enter any of 
the following:

sm

smi

smith

smith, robert

smith, robert taylor

smith, robert t

robert smith

robert taylor smith

robert t smith

You must enter an underscore (_) 
between the parts of multiword 
names. For example,

van_dyke, jo_anne

You can also enter only the 
beginning of the first and last 
names (at least the first two letters 
of the last name). For example,

sm, ro

ro sm

LookUp finds any record with a 
primary, birth, former, or other 
name like the name entered.

If you choose to add a new record 
after looking someone up by his or 
her name in this manner, then 
regardless of how you entered the 
name, each word in the name is 
transformed into lowercase and 
then capitalized appropriately; for 
example, if you enter van_dyke, 
jo_anne, you would get “Jo Anne 
Van Dyke.”
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Limit a name search. Enter any of the following after the 
name:

;c city

;st state/province

;z zipcode/postalcode

;f country

;y class

;s source

;ps status

For example, to find the Robert Smith 
whose preferred address is in 
Boston, enter the following:

robert smith ;c boston

You can string together more than 
one restriction for a search, 
separating each element of the 
search with a semicolon.

For example, to find the Robert 
Smith whose preferred address is 
in Boston and who is associated 
with the reunion class of 1954, 
enter the following:

robert smith ;c boston  
;y 1954

Search using a particular 
Social Security or Social 
Insurance number.

;ss SSN/SIN

For example, Mary Browning’s Social 
Security number is 964-99-8765. If 
she gives you her Social Security 
number instead of her ID number, 
enter the following to look her up:

;ss 964998765

You may enter hyphens, but they 
are not necessary.

Search using an organization’s 
name.

orgname

For example, to look for or add a new 
organization with the name of 
Universal Office Supplies, you could 
enter any of the following:

universal

office

supplies

universal office

universal office supplies

If you choose to add a new record 
after looking up an organization by 
its name, then regardless of how 
you entered the name, each word 
in the name is transformed into 
lowercase and then capitalized 
appropriately; for example, if you 
enter universal office 
supplies, you get “Universal 
Office Supplies.”

Table 2:  Person-Related and Organization-Related LookUp Shortcuts (cont’d)

Example Scenario LookUp Prompt Entry Hints
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Limit a name search. Enter any of the following after the 
name:

;c city

;st state/province

;z zipcode/postalcode

;f country

For example, if you wanted to find the 
Universal Office Supplies in Dayton, 
you could enter the following:

universal ;c dayton

Table 2:  Person-Related and Organization-Related LookUp Shortcuts (cont’d)

Example Scenario LookUp Prompt Entry Hints
62 Guide to User Interface 4.3, June 24, 2011
© 2011 Datatel, Inc.



Accessing Forms and Information
Adding Records from a LookUp

You can also use LookUps to add records from certain forms.

Table 3:  Adding Records from a LookUp Prompt

Example Scenario LookUp Prompt Entry Hints

Preserve capitalization as entered 
when adding a new person.

=name

For example, if you enter 
 
=JoAnne T di_Marco 
 
then the name is displayed exactly 
as you entered it.  
 
If you enter only  
 
joanne t di_marco 
 
then the name is capitalized as 
follows: 

Joanne T. Di Marco.

If the name is not preceded by an 
equal sign, then regardless of how 
you entered the name, each word 
in the name is transformed into 
lowercase and then capitalized 
appropriately.

Preserve capitalization as entered 
when adding a new organization.

=orgname

For example, if you enter  
 
=e e cummings Institute 
 
then the name will be displayed 
exactly as you entered it. If you 
enter only  
 
e e cummings Institute 
 
then the name is capitalized as 
follows:

E E Cummings Institute

Note:  On the Person Search Results panel, you can add new 
records only if you searched for records from the LookUp prompt and 
if the form allows you to add a new record. If you perform a person 
search first (before opening a form), the Add New Record button is 
not available because each form dictates whether new records can be 
added or not. If a form is open and you perform a search using the 
search feature rather than LookUp, the Add New Record button is not 
available. The LookUp prompt can be accessed by opening the form 
first or by finishing from the last person card in the Context Area. 
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Uploading and Downloading Files
With UI 4.3, you can upload and download files between your computer and 
Colleague if allowed by your Colleague System Administrator. Any user can 
export the contents of a form table to Excel, but only users with appropriate 
security access can upload or download files between Colleague and their 
computer.

See your Colleague System Administrator if you need to upload or download 
files and do not have access to the required forms.

Uploading Files to Colleague

Use the Colleague File Import (FLUL) form (see Figure 34) to upload a file 
from your computer to Colleague. Follow the steps below to upload a file.

Figure 34: The Colleague File Import (FLUL) Form

Step 1. Access the FLUL form.

Step 2. Complete the Target Directory and Target File Name fields. The Target 
Directory must be a valid UniData directory file. See the online help for more 
details.

Step 3. Enter Yes in the Execute Upload field. A message is displayed, alerting you 
that the system is requesting permission to upload a file (see Figure 35).
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Figure 35: Permission to Upload Dialog Box

Step 4. From the permission message, click Select File. Your computer’s file browser 
opens, and you can select the file you want to upload. 

Step 5. From your file browser, select the file and click OK. The file is uploaded to 
the target directory.

Step 6. When the file upload is complete, a message is displayed. Click OK from the 
upload complete message to return to UI 4.3. The FLUL form is closed when 
you return to UI 4.3.
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Downloading Files from Colleague

Use the Colleague File Export (FLDL) form (see Figure 36) to download a 
Colleague file to your computer. Follow the steps below to download a file.

Figure 36: The Colleague File Export (FLDL) Form

Step 1. Access the FLDL form.

Step 2. Complete the Source Directory and Source File Name fields. The Source 
Directory must be a valid UniData directory file. See the online help for more 
details.

Step 3. Enter Yes in the Execute Download field. A message is displayed, alerting 
you that the system is requesting permission to download a file (see 
Figure 37).

Figure 37: Permission to Download Dialog Box

Step 4. From the permission message, click Save As. Your computer’s file browser 
opens, and you can select the location and file name for the file that you are 
about to download. 

Step 5. From your file browser, select the file and click OK. The file is downloaded 
to the selected folder on your computer.
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Step 6. When the file download is complete, a message is displayed. Click OK from 
the download complete message to return to UI 4.3. The FLDL form is closed 
when you return to UI 4.3.
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Running Batch and Report Processes
Some Colleague forms let you specify information required to process data 
without further interaction (a batch process) or to create a report (a report 
process). When you run batch and report processes, a bar graph or message 
displays the progress of each process.

Batch and report processes display a progress bar dialog box to visually 
indicate progress (see Figure 38). Some show messages within the progress 
bar dialog box. For batches and reports that process only one item, the top and 
bottom progress bars both indicate overall progress. For batches and reports 
that process multiple items, the top progress bar indicates overall progress, 
and the bottom progress bar indicates progress for the current item being 
processed. The window at the bottom of the progress bar dialog box displays 
any messages related to the progress status.

When the batch or report process is completed, click Finish to return to 
Colleague. To return to Colleague automatically when the process completes 
without having to click Finish, select the Close automatically when 
complete check box.

Figure 38: Batch and Report Progress Bar Dialog Box 

Note:  Bar graphs and messages are not displayed when a batch or 
report is run in background mode.

Overall Progress Bar

Current Item Progress 
Bar

Message Area
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Using the Report Browser
The Report Browser allows you to view or print reports generated from 
Colleague. Follow the procedure below to generate and browse a report in 
Colleague.

Procedure for Browsing a Report

To use the Report Browser, perform the following steps.

Step 1. Access and complete the Colleague form that creates the desired report. Some 
batch processes provide an option for producing a report of the data 
processing changes made. Figure 39 shows an example of the Update Mail 
Codes (UMAI) form, which is a batch process that includes an option for 
generating a report. When you update from the form, the Peripheral Defaults 
form is displayed.

Figure 39: Update Mail Codes (UMAI) Form

Note:  For batch processes that can optionally generate a report, the 
Peripheral Defaults form is displayed only if you choose to generate a 
report (as shown in the Print Report field in Figure 39).
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Step 2. In the Output Device field on the Peripheral Defaults form (see Figure 40), 
select Hold/Browse    File    Output. When you update from the Peripheral 
Defaults form, the Process Handler form is displayed.

Figure 40: Output Device Field: Peripheral Defaults Form
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Step 3. Complete the Process Handler form (see Figure 41). When you update from 
the Process Handler form, the batch process runs and the report is generated. 

Figure 41: The Background Mode Form

Step 4. If the progress bar dialog box is displayed, monitor the progress of the batch 
or report and click Finish when processing is complete. 

Figure 42: Progress Bar Dialog Box 

Note:  The batch or report process displays the progress bar dialog 
box only if you entered No in the Execute in Background Mode field on 
the Process Handler form. See “Running Batch and Report 
Processes” on page 68 for more information about the progress bar 
dialog box.
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Step 5. When you click Finish from the progress bar dialog box, the Report Browser 
is displayed. Figure 43 shows a typical report page in the Report Browser.

Figure 43: Report Browser

Step 6. Use the toolbar buttons, shown in Figure 44, to navigate through the report, 
print the report, or save a copy.

Figure 44: Report Browser Toolbar Detail

Title Bar Tool Bar Exit Report 
Browser

Exit Report Browser

First Page Current Page/ Total Pages/ 
Change Page

Previous Page Next Page Last Page

Print Remote

Export PDF

Save As

Exit Report Browser

Report Browser Help
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The Report Browser Toolbar buttons are described in Table 4.

Table 4:  Report Browser Toolbar Buttons  

Button Name Description

Report Browser Help Opens the Report Browser help.

Exit Report Browser Closes the Report Browser and returns to the Colleague UI 4.3 window.

First Page Jumps to the first page of the report.

Previous Page Moves to the previous page of the report.

Current Page/Total 
Pages/Change Page

Shows the number of the currently displayed page and the total number 
of pages in the report. You can also jump directly to any page by typing 
the page number in this field and then pressing Enter.

Next Page Moves to the next page of the report.

Last Page Jumps to the last page of the report.

Save As Saves a copy of the report to your network or local hard drive. You are 
prompted to specify a name and path for the saved report.
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Export PDF Exports the report as a PDF file. When you select this option, the 
Export to PDF dialog box is displayed with various formatting options 
for the PDF file. When you select Export PDF, the Export to PDF 
dialog box is displayed:

The Export to PDF dialog box contains the following options: 

• Font: Select the font to be used for the text within the PDF file. 
Options include Courier, Helvetica, or Times New Roman. The 
default font is Courier. 

• Font Size: Enter the font size to be used for text within the PDF 
file. Enter a value from 1 to 100. The default font size is 10.0. 

• Orientation: Select whether the text within the PDF file should be 
displayed in the portrait or landscape orientation. The default page 
orientation is portrait. 

• Paper Size: Select the paper size of the PDF file. Options include 
Letter (8.5 x 11 in.), Legal (8.5 x 14 in.), Executive (7.25 x 10.5 in.), 
or Tabloid (11 x 17 in.). The default page size is Letter. 

Note: For best results when exporting a PDF file, you must choose an 
appropriate font size and page orientation. If the font is too large, the 
report may not page properly or may line wrap at the right margin. For 
reports that are up to 80 characters wide, use a font size of 10 and 
portrait orientation. For reports that are between 81 and 132 characters 
wide, use a font size of 8 and landscape orientation.

Print Remote Prints the report to a printer that is accessible from the Colleague host 
computer. This option uses the Colleague host operating system to 
print the report, without downloading it to your computer.

Technical Tip: Most PDF readers will scale a PDF document to fit the 
printer margins defined by the printer's print driver. If you are printing 
a document that requires a specific font size when it is printed, then 
you can compensate for this scaling when exporting the PDF. See 
AnswerNet page 8620 for more information.

Table 4:  Report Browser Toolbar Buttons (cont’d)

Button Name Description
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Accessing Multiple Environments
When your Colleague System Administrator installs UI 4.3, each installation 
is specific to one Colleague environment. Your administrator will provide you 
with the web address (URL) for accessing each environment that is set up for 
use with UI 4.3. 

If you need to access a specific Colleague environment with UI 4.3 and do not 
have connection or login information, see your Colleague System 
Administrator. 
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Keyboard Shortcuts
This section lists the keyboard shortcuts that you can use with UI 4.3.

The shortcuts listed below are available in UI 4.3 when you are not working 
within a UI form:

 Change focus to search box (toggles between Person and Form search): 
Ctrl+Shift+S 

 Show Search Results panel: Ctrl+Alt+R 

 Show Clear History dialog box: Ctrl+Alt+T 

 Show Advanced Person Search dialog box: Ctrl+Alt+A 

 Show Navigation Panel: Ctrl+Alt+N 

 Show Favorites Panel: Ctrl+Alt+F 

 Exit/Logout: Ctrl+Alt+L 

 Show Debug Information: Ctrl+Alt+B 

 Show Help (for current UI area in focus): Ctrl+Alt+H 

 Show Keyboard Shortcuts: Ctrl+Alt+K 

 View all records in Context Area (card selector drop-down): Ctrl+Shift+A 

 Map current record in Context Area: Ctrl+Shift+M 

 Map all records in Context Area: Ctrl+Alt+M 

 Close current record in Context Area: Ctrl+Shift+X 

 Close all records in Context Area: Ctrl+Alt+X 

 Add current record in Context Area to Favorites: Ctrl+Shift+V 

 Add all records in Context Area to Favorites: Ctrl+Alt+V 

 Go to next record in Context Area: Ctrl+Shift+N 

 Go to previous record in Context Area: Ctrl+Shift+R 

 Open Copy Window for current card in Context Area: Ctrl+Shift+C 

 Close open panels (and return to the main UI window): Esc 

Note:  Some of these shortcuts may not work in all browsers. Browser 
plug-ins or other applications may override these shortcuts and 
activate different commands.
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The keyboard shortcuts listed below are available only when working within a 
UI form (alternative keystroke combinations are separated by | ). Most of 
these commands are also accessible with the mouse from the Options menu. 

 Move to the next field: Tab 

 Move to the previous field: Shift+Tab 

 Open a drop-down list to select a value: Down Arrow 

 Scroll through the values in a drop-down list: Up/Down Arrow 

 Select the highlighted value in the drop-down list: Enter

 Move forward one row in a table: Down Arrow *

 Move back one row in a table: Up Arrow *

 Move forward one page in a table: Page Up 

 Move backward one page in a table: Page Down 

 Move to the previous form: Ctrl+Page Up (Windows) | Command+Page 
Up (Mac)

 Move to the next form: Ctrl+Page Down (Windows) | Command+Page 
Down (Mac)

 Move to the beginning of the current field: Home 

 Move to the end of the current field: End 

 Move to the first row of a table: Ctrl+Home 

 Move to the last row of a table: Ctrl+End 

 Field insert in a table: Insert

 Field delete in a table: Ctrl+Alt+D 

 Cancel from current form: F8 

 Cancel from all forms: Shift+F8 

 Finish from current form: Ctrl+F9 (Windows) | Ctrl+9 (Mac)

 Save current form: F9 | Ctrl+0 (zero, not the letter o) 

 Save all open forms: Shift+F9 (Windows) | Ctrl+8 (Mac)

 Detail: F2 

 Print active form: Ctrl+Alt+P 

 Help: Ctrl+Alt+H | F1 (shows help for area currently in focus; F1 may not 
work in all instances) 

 Change focus to UI Form Menu Bar (then use tab and arrow keys to access 
menu items): Ctrl+U

 Show Keyboard Shortcuts: Ctrl+Alt+K 

Note:  Some of these shortcuts may not work in all browsers. Browser 
plug-ins or other applications may override these shortcuts and 
activate different commands.
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*If the current field within a table has a drop-down list, use Down Arrow to 
open the list, Up/Down Arrow to move up and down within the list, and 
Ctrl+Up or Ctrl+Down to move back or forward one row within the table 
from that field.
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Using UI 4.3 Without a Mouse
Most of the UI 4.3 features can be accessed with either a mouse or a 
keyboard. If you are a keyboard-intensive data entry user, you should be able 
to navigate a form and access most of the data-entry-related features using the 
keyboard rather than switching back and forth between the keyboard and 
mouse. 

If you are a keyboard-intensive data entry user, keep the following points in 
mind:

 Study and learn the keyboard shortcuts shown in “Keyboard Shortcuts” 
beginning on page 76. Be aware that some of these shortcuts are different 
between Mac and Windows computers. If you happen to use both types of 
computer, familiarize yourself with both. You can access the keyboard 
shortcuts when working with Colleague by pressing Ctrl+Alt+K. If you 
are on a Windows computer, only the Windows version of the keyboard 
shortcuts is shown when you access the list of keyboard shortcuts. If you 
are on a Mac computer, only the Mac version is shown.

 Not all menu options have a shortcut. However, you can still access all 
menu items using the keyboard. Press Ctrl+M to access the menu bar, then 
you can use the arrow keys to highlight the menu item you want, then press 
Enter to select it.

 Some UI features that are not critical to data entry do not have shortcuts. 
For example, the controller that lets you page through a table within a UI 
form does not have a keyboard shortcut for exporting to Excel or for sliding 
the controller left or right if it is blocking your view of another field. 
However, keyboard shortcuts do exist for paging through the rows, 
columns, and pages of a table.

 For validated fields (ones with a drop-down to select a predetermined 
value) within a table, you need a way to access and select an item from the 
drop-down list in addition to a way to move to the next row. Normally, the 
up or down arrow moves to the previous or next row of a table, but for 
fields with drop-down lists, the down arrow key opens the drop-down list. 
When the list is opened, you can use the up and down arrow keys to scroll 
through the list and select a value. However, if you are on a validated field 
within a table, press Ctrl+Down or Ctrl+Up to move to the next or 
previous row.
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Viewing Online Help in UI 4.3
Online help provides you with detailed information about areas of the UI 4.3 
interface or Envision forms. A question mark icon is available on most UI 4.3 
areas, such as the Context Area, Search Results panel, Navigation panel, 
Favorites panel, and dialog boxes. Within a UI form, the traditional process, 
field, and how-to help is available for the form from either the UI Form Help 
icon or from the Help menu. 

Figure 45: Accessing Online Help in UI 4.3

Figure 46 shows an example of the help available for UI 4.3 areas such as the 
Context Area or Search Results panel.

UI Window Help

Context Area Help

UI Form Help
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Figure 46: Example UI 4.3 Context Area Online Help

The help Search text box lets you 
search for information in manuals 
(PDF files) and Tech Doc Online.

For all UI Area help topics, a 
single page of information specific 
to the UI Area is shown.

The title of the help page 
indicates the UI Area for this help 
topic.
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Figure 47 shows an example of the online help available for a UI Form. 
Contact your system administrator if the format of your help is displayed 
incorrectly.

Figure 47: Example of UI Form Help

The help Search text box lets you 
search for information in manuals 
(PDF files) and Tech Doc Online.

Process and field help for the current 
form is available in this section of the 
help page. Select View all help for 
this form to see all process and field 
help for the current form. 

The title of the help page 
indicates the UI Form for 
this help topic.

Online procedural help 
topics relevant to this UI 
form are listed in this 
section of the help page.

PDF files and Tech Doc 
Online pages relevant to this 
UI Form are listed in this 
section of the help page.
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47

Customizing UI 4.3
In This Chapter
This chapter helps you learn how to customize the look and feel of User 
Interface 4.3 with Colleague. It includes instructions for defining user 
preferences, setting Favorites, and customizing the field sequence for 
Colleague forms.
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Defining User Preferences
Many personal preferences for UI 4.3 can be set on the Preferences dialog 
box (see Figure 48). Changes to these preferences apply to your user profile 
only. 

To access the Preferences dialog box, select Options > Preferences from the 
menu bar.

Figure 48:  Preferences Dialog Box

Click on the Layout section header to expand it and view or change the 
following: 

 Color Theme. Select one of the available color themes. A preview of the 
color theme is shown. 

 Form Background Color. Select one of the available background colors 
for UI forms. 

Click on the Miscellaneous section header to expand it and view or change 
the following:

 Display Person Photos. If person photos are enabled at your institution, 
you can turn them on or off here for your own user profile. 

Note:  If photos are disabled at your institution, or if your security 
settings do not allow access to photos, then changing this option has 
no effect on your ability to see photos.
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 Number of Search Results Per Page. When search results are displayed, 
you can define how many results are included on a page. Adjust this 
number to avoid having to scroll within the Search Results panel to see an 
entire page of results. The Card View setting applies only to person search 
results (card view).

 Bar Graph. The bar graph shows status information for batch and report 
processes. See “Running Batch and Report Processes” beginning on 
page 68 for more details about this feature. To have this dialog box close 
automatically when a batch or report process is complete, select the 
Automatically Close When Finished option.

You can restore all default settings by clicking Restore Default Settings. 
Click Apply to save your changes but keep the Preferences dialog box open. 
Click Cancel to discard your changes and close the Preferences dialog box. 
Click OK to save your changes and close the Preferences dialog box.

If you are using UI 4.3 through the Datatel Portal, the Modify Your UI Single 
Sign-On Credentials link is available. Click this link if your UI 4.3 sign-on 
credentials change and you need to reset them for single sign-on access 
through the portal.
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Adding and Accessing Favorites
You can use the Favorites feature to save forms and person records that you 
use frequently to the Favorites panel, so that you can access them quickly.

Adding Favorites

Use the Add to Favorites feature to add the current form or people to your 
list of Favorites. 

You can access the Add to Favorites dialog box (see Figure 49 for an 
example of the Add Person to Favorites dialog box) by clicking the Star icon 
in the UI form area, the Context area, or in the Favorites panel, or by using 
one of the following keyboard shortcuts:

 Add current person in Context Area to Favorites: Ctrl+Shift+V 

 Add all person records in Context Area to Favorites: Ctrl+Alt+V 

Figure 49: Add Person to Favorites Dialog Box
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Complete the following fields on the Add to Favorites dialog box to add 
items to your list of Favorites:

 Name. Shows the name of the person (one or more) or the form (only one) 
that you have selected to add to Favorites. 

 Add to Folder. Select an existing folder from the drop-down list, or click 
New Folder to create a new folder for the selected items. You can create 
nested folders if needed. 

 Click Add to add the listed items to the selected Favorites folder. 

 To view and manage your existing Favorites, click the Favorites tab at the 
top of the UI window to open the Favorites panel. 

Accessing Favorites

Use the Favorites panel to retrieve and manage saved People, if allowed, or 
Forms Favorites. 

You can access the Favorites panel by clicking the Favorites tab at the top of 
the UI window or by using the keyboard shortcut: Ctrl+Alt+F.
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Figure 50: Favorites Panel

Selecting People (if allowed) from Favorites

If allowed, to select one person from Favorites, navigate through the folders 
to locate the person record that you want to work with. 

Click the record to highlight it, and then click Open to add that person’s 
record to the Context Area. You can also double-click a record to open it. 

To select multiple people from Favorites, navigate through the folders and 
locate the person records that you want to work with. Use Shift+Click to 
highlight a continuous group of records. Use Ctrl+Click to highlight multiple 
records that are not in a continuous list. When using Ctrl+Click, you can 
click again on a highlighted record to cancel that selection. Click Open to add 
all highlighted people records to the Context Area. 

Note:  To expand a folder, click the triangle to the left of the folder 
name. Double-clicking a folder name will add all person records in that 
Favorites folder to the Context Area.
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To retrieve an entire folder of people records from the Favorites panel, 
highlight the folder name, and then click Open to add all records in that folder 
to the Context Area. You can also double-click a folder name to add all 
records in that folder to the Context Area. 

Selecting a Form from Favorites

You can select only one form at a time from the Favorites panel. Navigate 
through the folders to locate the form you want. Click the form to highlight it, 
and then click Open. 

Selecting People (if allowed) and Forms Together from 
Favorites

From the Favorites panel, you can select one or more people records and a 
person-related form at the same time. Highlight the people records you want 
to work with, and then highlight the form you want to use. Click Open. The 
people are added to the Context Area, and the form is opened with the first 
person’s information loaded in. 

Managing Favorites

From the Favorites panel, you can drag items from one folder to another. You 
can also drag entire folders to different levels within the folder structure. 

In the upper right corner of the People Favorites area and the Form 
Favorites area, there is an Options button with a drop-down list of available 
options. Use these options to manage your Favorites:

 Create Shared List (available only from the People Favorites Options 
button). Use this option to create a shared list of people records (stored as a 

Note:  To expand a folder, click the triangle to the left of the folder 
name. 

Note:  To expand a folder, click the triangle to the left of the folder 
name. 

Note:  When selecting people and a form together, person information 
is loaded into the form only if the form uses the Person record as the 
primary LookUp. Otherwise, the selected people are loaded into the 
Context Area but not used until you open a form that uses the person 
record as the primary LookUp.
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saved list in Colleague). See “Creating a Shared List from Favorites” on 
page 90.

 Recently Created Shared List. Use this option to view the last ten recently 
created shared lists.

 Collapse All. Use this option to collapse all Favorite People or Form 
folders.

 Expand All. Use this option to expand all Favorite People or Form folders.

 Rename. Use this option to edit or rename a folder or item in your list of 
saved people or forms. Highlight the folder or item you want to rename, 
and then select Rename from the Options button drop-down menu to edit 
or rename the selected item.

 Remove Selected. Use this option from the People Favorite Options 
button to remove one or more people or people folders from your Favorites. 
Use this option from the Form Favorite Options button to remove one or 
more forms or form folders from your Favorites. Select the items you want 
to remove, and then select Remove Selected from the Options button 
drop-down menu to remove them from your Favorites.

Creating a Shared List from Favorites

Follow these steps to create a shared list of people records from existing 
People Favorites. For example, if you create a list of students that is the 
definitive list of students in the class of 2010, you can share it with other users 
who need to work with the same list of students. The shared list ensures that 
everyone works with the same group of people, and each user does not have to 
create his or her own list individually. 

Step 1. Select one or more people from your Favorites, or a folder of people.

Step 2. From the People Favorites area of the Favorites panel, open the Options 
button and select Create Shared List. The Create Shared List dialog box 
appears (see Figure 51). 

Note:  This option does not change the name of the person or form in 
Colleague. The item is renamed only in your Favorites.
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Figure 51: The Create Shared List Dialog Box

Step 3. Complete the Shared List dialog box as follows:

a. Shared List Items: Shows the names of the people selected from your 
Favorites that will be stored in the shared list that you are about to create. 

b. Shared List Name: Enter the name to use for the shared list. This list is 
stored as a saved list in Colleague. Be sure to follow your institution’s 
naming conventions when saving the shared list. If you enter a shared list 
name that already exists, you will be prompted whether to overwrite it. 
The saved list name is stored in all uppercase letters, regardless of the case 
used when creating the name. Click the Recently Created Shared Lists 
link to view the last ten recently created shared lists. 

Step 4. Click Create to create the shared list and exit the Create Shared List dialog 
box. The shared list is created in Colleague as a saved list.

Step 5. You or any other user in this Colleague environment can retrieve an existing 
shared list from the Advanced Person Search dialog box (see “Advanced 
Person Search” beginning on page 45 for more information). When another 
person retrieves this shared list, privacy settings and record security are 
applied to ensure that the user does not access restricted information.
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Customizing the Field Sequence and 
Properties for a Form

The behavior for each field on each form is originally defined by Datatel. The 
system administrator at your institution can use Colleague Studio to further 
define and customize field behavior. If allowed, you can also modify certain 
field behaviors for the forms that you access. 

You can use field customization to determine the tab sequence of fields on a 
form. Customizing your field sequence can help you move through a form 
more quickly than you would if you had to tab through each field on the form. 
You can specify the field you want to start in first, the order in which to visit 
each subsequent field, and the last field to complete before updating from the 
form. Each time you press the Tab or Enter key, you move to the next field in 
the specified tab sequence (skipping any fields not in the tab sequence). If you 
specify a last field, the form updates when you tab from the last field in your 
customized tab sequence. If tab sequencing is not specified, the default 
sequence is used.

Use the Customize Field Sequence & Properties dialog box (available from 
the Options menu) to specify field sequence and field access for fields on the 
current form (see Figure 52). The example in Figure 52 shows field 
customization properties for the NAE form. Any form can be customized if 
you are allowed to customize the field properties.

The Customize Field Sequence & Properties dialog box includes the 
following options for customization:

 Field Sequence. Lets you can specify a first field, last field, and next field 
for tab sequence.

 Field Access. Lets you specify which fields on the form are Required, 
Inquiry Only, or No Access.

When you access the Customize Field Sequence & Properties dialog box 
for a form, a series of “tool tips” indicates the field identifier number and tab 
sequence of each field. Tool tips are the numbered boxes displayed on each 
field when you open the Customize Field Sequence & Properties dialog 
box. Field identifier number tool tips are shown in yellow boxes, and tab 
sequence tool tips are shown in orange boxes. A green tool tip for a field 
indicates that the field properties are customized for that field.

Note:  Before you can customize fields for a form, your Colleague 
System Administrator must first enable the field customization 
features for you and set up your field customization preferences.
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See “Procedure for Customizing Fields on a Form” beginning on page 95 for 
the procedure for customizing the field sequence for a form.

Figure 52: Customize Field Properties Dialog Box for the NAE Form 

Example of tab sequence 
number tool tip  
(orange tool tip)

Example of field identifier 
number tool tip  
(yellow tool tip)

The Customize Field 
Properties Dialog Box

Example of 
customized tool tip 
(green tool tip)
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Limitations on Customizing Field Properties

Field Sequence Customization Limitations

The behavior for each field on each form is originally defined by Datatel. 
System administrators can use Colleague Studio to further define field 
behavior for an institution. You cannot take away behavior that is already 
defined for fields on a form. The following rules apply when customizing 
field sequences:

 Precedence
• Tab sequence precedence is exclusive. If your Colleague System 

Administrator creates a tab sequence and applies it to some or all users, 
you can still create a different tab sequence for yourself (if allowed), and 
that tab sequence will apply only to your login ID.

 First Field
• You can make only one field first in the sequence. Therefore, if another 

field has already been specified as the form’s first field, locate that field 
and clear the selection.

 Last Field
• You can specify more than one field as the last field on a form. However, 

when specifying a field as last, you cannot also select a next field override.

 Next Field Override
• If a field is specified as last, you cannot select a next field override. 
• Other fields that cannot have a next field override include:  

—Fields contained in the header area. 
—Table fields that are not table controllers (unless the current 
 field is a member of the same table).
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Field Access Customization Limitations

When customizing the field access properties, you cannot take away behavior 
that either Datatel or your system administrator has already defined for the 
fields on a form. For example, if a field is defined as Required, it is always 
required and cannot be changed to Inquiry Only or No Access. However, a 
standard (not required) data entry field can be customized as required. 

 Precedence
• Field access precedence is inclusive. If your Colleague System 

Administrator restricts field access from a field for all users, you cannot 
customize the field access properties to allow access to that field for 
yourself. 

 Field Access
• Fields appearing in the form’s header area can only have No Access 

restrictions applied to them. Only the visible fields in the header area can 
be set to No Access.

• You can only apply one field access restriction (Required, Inquiry Only, or 
No Access) to a field.

• If a field is already specified as required, you cannot modify any of the 
access options.

• If a field is already specified as no access by Envision security, you cannot 
modify any of the access options.

• If a field is already specified as inquiry-only, your only available field 
access customization option is to specify the field as no access.

Procedure for Customizing Fields on a Form

This procedure assumes that your Colleague System Administrator has 
provided you with the ability to customize field properties for Colleague 
forms. If you do not have access to this feature, see your Colleague System 
Administrator.

Step 1. Access the form that you want to customize.

Step 2. From the Options menu, select Customize Field Sequence & Properties to 
display the Customize Field Sequence & Properties dialog box (see 
Figure 53). When the dialog box is displayed, the tool tips on the current form 
are also displayed.
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Figure 53: The Customize Field Properties Dialog Box

Step 3. In the When I am on field drop-down list, select the number of the field you 
want to modify. Refer to the field identifier tool tips displayed on the form to 
select the number of the field you want to modify.

Step 4. Indicate the field sequence customization you want to apply to the field.

 To set a field as first in the form, select the appropriate field number from 
the When I am on field list and then select the Make this the first field on 
the form check box. When entering the form, the cursor will appear in this 
field, which is the first field in the form’s tab sequence.

 To set a field as last in the form, select the appropriate field number from 
the When I am on field list and then select the Make this the last field on 
the form check box. This is the last field in a form’s tab sequence, which 
means the form will update and you will leave the form after you leave this 
field.

 In the The next field should be list, you can specify where the cursor 
should move when leaving the field currently selected in the When I am on 
field list. If you do not select a field override from this list, the next field in 
the default tab sequence is used. For example, if you want to enter data into 
field 10 on a form then move directly to field 15, select 10 from the When 
I am on field list, and then select 15 in this list. Refer to the field identifier 
tool tips displayed on the form to select the number of the field you want to 
modify.

Step 5. Indicate the level of field access that you want to apply to the selected field. 

 Select the Required check box to ensure that the field currently indicated 
in the When I am on field list is completed before finishing from the 
selected form.

 Select the Inquiry Only check box to make the field currently indicated in 
the When I am on field list non-editable. This option lets you view data in 
this field, but you cannot update or delete data.

 Select the No Access check box to prevent viewing, adding, changing, or 
deleting data from the field currently indicated in the When I am on field 
list.
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Review the “Field Access Customization Limitations” on page 95 for an 
explanation of which options are available for each field. Any changes made 
that violate the customization limitations will appear to be saved, but these 
changes will not be honored.

Step 6. Repeat steps 3 through 5 for each field that you want to customize.

Step 7. Click Save when you have finished your field customization settings to save 
all changes and exit the dialog box. Test your field customizations and adjust 
them as needed until the form behaves the way you expect it to. You must 
close and then reopen the form you have customized to test it.

Step 8. If allowed by your institution, you can copy the current customizations to a 
specific set of users. Click the Copy to other users link and select the users 
from the list to whom you want to copy the current set of customizations. 
After selecting the users, click Copy and then Save to submit the 
customizations to those users and exit the Customize Field Sequence & 
Properties dialog box.

Users listed in bold red text have existing customizations. Copying 
customizations to users will overwrite any existing customizations that those 
users have defined. Additionally, copying does not establish a permanent link; 
therefore, further changes made after copying will not be reflected for those 
users.

Procedure for Disabling Field Sequence

After you set up custom field sequencing, there may be a situation where you 
need to temporarily disable your customizations. Follow this procedure to 
disable and then re-enable your field sequence customizations. This feature 

Note:  You do not need to click Save after customizing each field. You 
can click Save after making customizations to all of the fields on a form 
to apply all of the customizations. Clicking Save will save all changes 
and exit the dialog box. 
 
Click Clear This Field to remove customizations for the currently 
selected field and return to the default settings. Customizations for all 
other fields on this form are left unchanged.  
 
Click Clear All Fields to remove all existing field customizations for 
the current form and return to the default settings.
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disables only your own customizations. If your Colleague System 
Administrator has customized this form for all users, those customizations can 
not be disabled.

Step 1. Access the form that you customized.

Step 2. From the Options menu, select Disable Custom Field Sequence. If this 
option is not selected, it indicates that the field customizations are in place. If 
this option is checked, it indicates that the field customizations are 
temporarily disabled. To temporarily disable the field customizations, make 
sure this option is checked.

Step 3. To re-establish your custom field sequence changes, clear the Disable 
Custom Field Sequence option.

Procedure for Showing Field Sequence

You can display the current field sequence of the current form. The field 
sequence for each field is displayed as a number in the tool tip for that field. 
Any fields with customizations appear with green tool tips. The fields with 
default field sequence settings appear with orange tool tips.

Step 1. Access the form for which you want to see the field sequence.

Step 2. Select Options > Show Field Sequence. Tool tips appear for each field on the 
form. The number in each tool tip indicates its field sequence.

Step 3. To hide the tool tips showing the field sequence and return to the form, click 
anywhere on the form.

Note:  This option does not disable field access level customizations.
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